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Abstract

A major area of interest in a muffler design is in its acoustic and flow performance. Other parameters

in design are weight, availability of space and reliability of operation. Transmission Loss (TL)

and Insertion Loss (IL) of a muffler are good indicators of acoustical performance. These values

are computed by using methods such as one-dimensional transfer matrix, two-dimensional mode

matching method, Green’s function method, Finite-Element Method (FEM) and Boundary Element

Method (BEM). Pressure drops across muffler influence its functioning. It is known that acoustic and

flow performance parameters are contradicting. An efficient muffler design should have a minimum

pressure drop and as high transmission loss as possible. Extended Inlet and Extended Outlet (EIEO)

muffler has a wider frequency band acoustical performance as compared to a Simple Expansion

Chamber (SEC). A methodology is developed for EIEO muffler to optimize both acoustic and flow

parameters using one-dimensional study.

This study works well for low to medium operating frequencies. As the chamber parameters change,

one-dimensional analysis is not alone sufficient. The high-frequency waves, due to their short wave-

length, tend to travel in all the three directions. The plane-wave assumption does not hold for

short chamber mufflers. To get more accurate results, a three-dimensional methodology is more

suitable. An EIEO muffler can be considered as a combination of circular and annular cavities.

Literature to estimate the transmission loss of circular cavity, analytically using Green’s function

has already been deveoped. Thus, an analytical approach for the transmission loss characteristics

of an annular cavity with arbitrary locations of inlet and outlet ports has been established in this

thesis. The analytically obtained results for various configurations are validated numerically using

FEM software. The analytical resluts were found to be in good agreement with those obtained using

fininte element method.
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C2 Constant used for y/x

D Chamber diameter in mm

d Pipe diameter in mm

la Extended inlet length in mm

lb Extended outlet length in mm

lg Acoustic gap length in mm

p1 Acoustic pressure at the inlet

p2 Acoustic pressure at the outlet

q Velocity ratio

U0 Mean flow velocity in m/s

2



v1 Volume velocity at the inlet

v2 Volume velocity at the outlet

x Axial position

xmax Maximum core jet length in mm

y Normalized jet height

Chapter 3

δ Face port location

ω Natural frequency in rad/s

φ Velocity potential

Ψ Mode function

a Inner diameter of cavity

a1 Half major axis length of inlet port

a2 Half major axis length of outlet port

b Outer diameter of cavity

b1 Half minor axis length of inlet port

b2 Half minor axis length of outlet port

kzp Axial wavenumber

L Cavity length

m Circumferential mode order

n Radial mode order

P Acoustic pressure

p Axial mode order

u1 Hypothetical velocity of inlet piston

u2 Hypothetical velocity of outlet piston

3



Chapter 1

Introduction

1.1 Basic concepts of acoustics

A few basic terms and concepts that will be useful throughout the thesis are defined in this section.

An acoustic wave can be typically described using five variables. They are wavelength, speed of

propagation, amplitude, frequency and wavenumber. The speed of propagation is the speed at

which an acoustic wave propagates through a medium. The speed of propagation depends only

on the medium through which it propagates and the environmental conditions. The wavelength is

the spatial period of the wave. The frequency is defined as the number of oscillations occurring

in one second. The frequency, speed of propagation and wavelength are related to one another.

This relation is given in Eq. 1.1. The amplitude is the magnitude of oscillation of the wave. The

wavenumber is the spatial periodicity of the wave. It is expressed in units of reciprocal of meters.

The wavenumber can be calculated from Eq. 1.2.

c = fλ (m/s) (1.1)

k =
2π

λ
(m−1) (1.2)

where c is the speed of sound, f is the frequency and k is the wavenumber.

The speed of sound in air varies with temperature given by Eq. 1.3

c = 20.05
√
T (m/s) (1.3)

1.2 Measurement of muffler acoustic performance

Mufflers are well known noise control solution along the path. The acoustical performance of a

muffler is measured in three ways: insertion loss, transmission loss and noise reduction. Insertion

loss is the difference of sound pressure levels before and after a muffler is installed in the system.

Transmission loss gives the loss of acoustic power of a wave as it travels through a muffler. Noise

reduction is the comparison of the sound pressure levels of a point upstream of the muffler and a

point downstream of the muffler. Each of these performance standards will be explained in more
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detail in further sections. Two more terms that are useful to define are acoustic impedance and

characteristic acoustic impedance. Acoustic systems may be analysed as an equivalent impedance

circuits, same as done for electrical circuits. Acoustic impedance represents the pressure change

created by a wave divided by the volume velocity that is imparted to the medium by the same

wave. Acoustic impedance is a property of the device that a wave is travelling in. The characteristic

acoustic impedance is the ratio of the acoustic pressure to the acoustic mass velocity of a progressive

wave.

1.2.1 Insertion loss

Insertion loss is defined as the reduction in sound power transmitted through a duct compared to

that transmitted with no muffler in place [1].

IL = 20 log10

(
Pr
Pm

)
(dB) (1.4)

where IL is the insertion loss, Pm is the measured sound pressure with the muffler installed and Pr

is the measured sound pressure without the muffler.

There are two main advantages in using IL as the standard of performance. The first advantage is

that, for a given system, conceptually, IL is the actual performance of a muffler. It is the comparison

of the duct system before and after the muffler is installed. It is simple to measure. The second

advantage is that IL measurement is comparatively easy, and only requires one microphone [2].

The disadvantage of IL is that it is system dependent. Both the source impedance and the load

impedance must be taken into consideration when predicting IL. This system dependence causes

another disadvantage which is for the same muffler is used, the insertion loss can be different for

different systems, different sources, and different loads.

1.2.2 Transmission loss

Transmission loss is defined as the ratio of incident sound power and transmitted sound power.

Transmission loss does not depend on the source parameters and an anechoic termination at the

downstream end is assumed [3].

TL = 10 log10

(
Wi

Wt

)
(dB) (1.5)

where TL is transmission loss, Wi is the incident sound power and Wt is the transmitted sound

power.

Transmission loss can be easily calculated as it is independent of the source and load characteristics

unlike insertion loss. This makes TL much more popular in the research area, because performance

of mufflers and muffler elements can be easily estimated. The fact that though TL is source-

independent, its measurement is much more complex than that of IL. Incident and transmitted

waves must be properly isolated so that calculation of transmission loss can be done easily.
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1.2.3 Noise reduction

The level difference between the sound pressure between two points in a system is known as noise

reduction [1]. For a muffler, one point should be upstream and the other point should be downstream.

Noise reduction is similar to insertion loss and it can be measured very easily. The disadvantage

of noise reduction is that it is load dependent thus making it hard to predict and calculate. The

formula for noise reduction is:

NR = 20 log10

(
Pu
Pd

)
(dB) (1.6)

where NR is noise reduction, Pu and Pd are the sound pressures at the upstream and downstream

points respectively.

1.3 One-dimensional analysis

One dimensional plane wave theory is used for analysis of acoustic mufflers since the past few

decades. In this theory, it is assumed that the pressure remains constant in a given cross-section

perpendicular to the direction of propagation. Thus, there exists an acoustic pressure variation only

along the longitudinal direction. This assumption holds for small mufflers installed on the car engines

[3]. However, as the size of the duct increases with respect to the acoustic wave, the wave is allowed

to propagate in all the three directions. The following sections will explain this phenomenon of

three-dimensional propagation, its effects, and the difficulties that arise in analyzing and predicting

these effects.

1.4 The need for multi-dimensional analysis

A plane wave assumption is valid for frequencies below cut-on frequency. Higher order modes will

propagate above the cut-on frequency. At low frequencies, one-dimensional analysis is appropriate

for muffler analysis. Each mode has a particular cut-on frequency above which it is allowed to

propagate. The cut-on frequency for a rectangular duct is given as [3]:

fc =
c
√

1−M2

2π

√(mπ
a

)2

+
(nπ
b

)2

(Hz) (1.7)

where fc is the cut-on frequency in Hz, c is the speed of sound in the duct medium in m/s, M is the

Mach number, a and b are the duct dimensions in metre. while m and n are the number of cross

nodes along the duct dimensions a and b respectively.

Fig 1.1 describes the mode shapes for a rectangular duct cross-section. In this figure, the solid lines

represent the walls of the duct while the dotted lines represent the nodes of acoustic pressure in

the corresponding direction. The area in between the lines represents the alternating maximum and

minimum pressure regions of the wave as denoted by the ”+” and the ”–” signs respectively [3].

The cut-on frequencies for a circular duct are similar to that of a rectangular duct. Only in this

case, diameter is the measurement of interest and instead of cross modes in two directions there are

circumferential and radial modes. The cut-on frequencies for a circular duct are given by [3]:
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Figure 1.1: The mode shapes of the first three cut-on frequencies of rectangular duct

Figure 1.2: The mode shapes of the first three cut-on frequencies of circular duct

fc = Jmn ×
c

πD

√
1−M2 (Hz) (1.8)

where D is the diameter of the duct, and Jmn is the zero of a Bessel function for the mode of interest,

m is the order of the Bessel function or the circumferential modes and n is the number of radial

nodes. This labeling scheme is shown in Fig. 1.2. Plus and minus signs are added to the antinodes
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in the first few modes.

1.5 Motivation

Acoustic mufflers are used in a number of applications requiring the suppression or attenuation of

sound. Acoustic mufflers make everyday life much more pleasant. Many common appliances, such

as refrigerators and air conditioners, use acoustic mufflers to produce a minimal working noise. The

application of acoustic mufflers is mostly directed to machine components or areas where there is a

large amount of radiated sound such as high pressure exhaust pipes, gas turbines, and rotary pumps.

Although there are a number of applications for acoustic mufflers, there are really only two main

types which are used. These are absorptive and reactive mufflers. Absorptive mufflers incorporate

sound absorbing materials to attenuate the radiated energy in gas flow. Reactive mufflers work

on the principle of impedance mismatch. It uses a series of complex passages to maximize sound

attenuation while meeting set specifications, such as pressure drop and volume flow.

The design and analysis work for these mufflers has been mostly done with one-dimensional plane

wave theory in terms of transfer matrix approach. However, when the size of the muffler is in

the order of cut off wavelength, the higher order modes will also propagate. So, it requires a

multi-dimensional approach. The main goal of this research is to optimise the flow and acoustic

performance of a short chamber muffler.

Green’s function is one of the methods used to evaluate the transmission loss of mufflers by developing

a three-dimensional transfer matrix method as this gives a practical insight into the performance of

mufflers.

1.6 Literature overview

One-dimensional transfer matrix modeling (Sec. 2.1) has been the one of the most common methods

used for analysis of mufflers. Based on this theory, the TL curve for a simple expansion chamber

can be obtained. Due to the extensions of the inlet and outlet pipes, the TL curve is improved.

Although, these relations do not hold true in reality because they fail to consider the effect of three-

dimensional (3-D) evanescent waves due to area discontinuities. This effect is rectified by the use of

end corrections [4, 5]. Different analytical [4] and numerical [5] methods have been used in the past

to estimate the end-corrections of sudden expansion and sudden contraction. Expression for the end

correction were derived after extensive parametric studies [6]. P. Chaitanya et. al. [7] studied the

effect of wall thickness on the end corrections and established a correlation between the geometric

and the acoustic lengths.

One also needs to consider the fluid flow requirement in the design. In case of an extended inlet and

outlet, higher back pressure happens because of flow expansion of the fluid inside the chamber. The

flow exhausting from the inlet pipe forms the jet from inlet pipe to outlet pipe in the slow moving

air-stream. The jet structure formation strictly depends on the respective inlet flow conditions.

An analysis of flow inside the EIEO muffler by using computational fluid dynamics model gives an

insight of the flow expansion behaviour. Various parameters are considered for parametric study

such as inlet flow velocity, inlet pipe dimensions, chamber dimensions and fluid properties. The

extended pipe lengths are decided considering the constant flow conditions which should establish a

8



continuous jet structure from inlet to outlet pipe.

It is important to study fluid flow behaviour in an extended inlet and outlet muffler to reduce pres-

sure loss between two ends. A lot of strategies are put forth in the CFD domain to calculate back

pressure. The perforated and cross-flow type reactive mufflers were studied using CFD by S. N. Pan-

igrahi et al. [8]. Fang et al. [9] discussed the influence of an inlet velocity on pressure distribution

inside the muffler by using CFD and experiments. D. C. Wilcox [10] developed a numerical proce-

dure to compute the velocity profiles of an axisymmetric plane jet. Aliakbar et al. [11] performed

CFD simulations on SEC mufflers and devised a methodology for the EIEO muffler by making use

of acoustics and fluid dynamics along with optimization tools. An optimum design was established

which is found to be suitable for short-chamber mufflers.

In this case, the length and the diameter are of comparable magnitude. Thus, the acoustic pressure

variation takes place in all the three directions. Hence, a one-dimensional analysis is not alone suffi-

cient to get a complete idea of the performance of the mufflers. This prompted the use of advanced

three-dimensional methods like finite element method, boundary element method using simulation

software.

The transmission loss characteristics of an annular cavity give insights for the designing of mechan-

ical systems like the exhaust mufflers of automobiles and refrigerator compressors. Au-Yang [12]

discussed about the analytical method for the acoustic pressure distribution inside an annular-like

water reactor induced by a coolant pump. The model includes variations due to minor differences

in the blade passing frequency of the pump. Experimental method was used to verify the model.

Kim and Soedel [13] developed an analytical method to establish the pressure response of the system

for three-dimensional wave propagation by utilizing modal expansion. A point source model was

proposed to formulate the pressure response. An idea of formulation of the four pole parameters

based on this pressure response was introduced. The results were applied for an annular cavity so

that it can be later used in combination for a complete system.

Zhou and Kim [14] later revised the above point source model by investigating the shortcomings of

a singularity arising at the source point in the model. A new surface model was put forth instead

along with a new definition of input point impedance.

Kim Hann [15] used the Green’s function method to study the acoustic characteristics of a circular

chamber with arbitrary inlet and outlet locations. Homogeneous boundary conditions were used for

the solution of Green’s function. Chamber walls were considered as rigid and the acoustic source

location was assumed to be of uniform volume. Theses solutions were compared with experimental

results and modal expansion techniques.

B. Venkatesham et al. [16] performed a transmission loss analysis using Green’s function method.

This was done using a rectangular expansion chamber with arbitrary inlet/outlet locations. Piston

analogy approach was used to model the ports with a plane wave excitation. Average pressure on

each of the ports is estimated and transfer matrix is derived for calculation of transmission loss.

1.7 Thesis outline

The thesis is divided into six chapters. The first chapter gives a brief introduction about the general

concepts of acoustics and various performance measurement techniques for mufflers. Chapter 2 talks

about the optimum design methodology used for analysis of EIEO muffler.
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An EIEO muffler can be considered as a combination of annular and circular cavities. The literature

for circular cavities already exists. Thus, it is required to develop an analytical approach for the

estimation of transmission loss of an annular cavity. It is discussed in chapter 3. Chapter 4 is about

the finite element analysis. It also explains about the software LMS Virtual.Lab and its use in

estimation of transmission loss. The analytical results and its comparison with the numerical results

are a part of Chapter 5. The sixth chapter summarizes the conclusions of the thesis work. The last

chapter discusses about the future scope of the research.
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Chapter 2

Optimum design methodology

2.1 Transfer matrix modeling

One dimensional plane wave theory assumes constant pressure in a given cross-section perpendicular

to the direction of propagation. Thus, there exists an acoustic pressure variation only along the

longitudinal direction. This assumption holds good for low frequency analysis. This also implies that

each subsystem is a two-port system with two unknown parameters, which are the two interfering

waves traveling in opposite directions. Such systems can be described by a transfer matrix. The

elements of this matrix are known as four pole parameters [2, 17].{
p1

v1

}
=

[
T11 T12

T21 T22

]{
p2

v2

}
(2.1)

where p1 and p2 is the acoustic pressure; v1 and v2 are the volume velocities; at upstream and

downstream respectively, and T11, T12, T21, T22 are the four pole parameters.

The transfer matrix for a uniform area tube or a pipe with rigid walls is given by [18]

1
(Upstream)

𝑙𝑙

2𝑟𝑟 2
(Downstream)

Figure 2.1: A rigid wall tube with uniform diameter
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{
p1

v1

}
=

[
cos kl jZ0 sin kl
j
Z0

sin kl cos kl

]{
p2

v2

}
(2.2)

where Z0 is the acoustic impedance of the tube.

The expression for TL is given by [2]:

TL = 20 log10

[√
Z2

Z1

∣∣∣∣T11 + T12/Z2 + T21Z1 + T22Z1/Z2

2

∣∣∣∣
]

(2.3)

Simple expansion chamber (SEC)

The simplest muffler configuration is a simple expansion chamber. It can be considered as analogous

to a low pass filter correlating to electrical network theory. A schematic of SEC is shown in Fig. 2.2

𝑙𝑙

2𝑅𝑅2𝑟𝑟

Sudden 
expansion

Sudden
contraction

𝑙𝑙1 𝑙𝑙2

1 3 42

Figure 2.2: A simple expansion chamber

The transfer matrix for the SEC muffler can be written by multiplying the transfer matrices of the

inlet, the chamber and the outlet.{
p1

v1

}
= [TM1→2] [TM2→3] [TM3→4]

{
p4

v4

}

=

[
cos kl1 jZ1 sin kl1
j
Z1

sin kl1 cos kl1

][
cos kl jZ0 sin kl
j
Z0

sin kl cos kl

][
cos kl2 jZ2 sin kl2
j
Z2

sin kl2 cos kl2

]{
p4

v4

} (2.4)

where l1, l2 are the lengths; and Z1, Z2 are the acoustic impedances of the inlet and the outlet pipes.

By making use of distributed element transfer matrix for chamber length l and combining with Eq.

2.3, the formula for TL of a simple expansion chamber can be written as [2]:

TL = 10 log10

[
1 + {

(
m− 1/m

2

)
sin(kl)}2

]
(2.5)

where m is the area expansion ratio, m = (R/r)
2
, and the product of kl is called Helmholtz number

or non-dimensional frequency.
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Figure 2.3: Transmission loss curve for SEC with r = 15 mm, R = 45 mm for l/D = 2

The TL curve for SEC is shown in Fig. 2.3. It is observed that troughs in transmission loss of a

simple expansion chamber occur at a Helmholtz number of kl = nπ and peaks at kl = nπ/2.

Extended inlet extended outlet (EIEO) chamber

𝑙𝑙

Extended
inlet

Extended
outlet

𝑙𝑙𝑎𝑎 𝑙𝑙𝑔𝑔 𝑙𝑙𝑏𝑏

𝑙𝑙1 𝑙𝑙2

1 3 42 65

Figure 2.4: An extended inlet extended outlet chamber

Schematic of an EIEO chamber is shown in Fig. 2.4. The inlet and outlet pipe of an SEC when

extended into the chamber, form the EIEO chamber. The extended lengths of the inlet and the outlet

are denoted by la and lb respectively. The extended lengths act like shunt impedances analogous to

the electrical network. The two branch impedances are given by [18]

Za = −jYa cot (kla) and Zb = −jYb cot (klb) (2.6)
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where Ya = Yb = c/Sann is the characteristic impedance of the annulus; and Sann is the annular

cross-section area.
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Figure 2.5: Transmission loss curve for EIEO chamber la = 90 mm; lb = 45 mm for l/D = 2

{
p1

v1

}
= [TM1→2] [TM1→2→3] [TM3→4] [TM3→4→5] [TM5→6]

{
p6

v6

}

=

[
cos kl1 jZ1 sin kl1
j
Z1

sin kl1 cos kl1

][
1 0
1
Za

1

][
cos klg jZ2 sin klg
j
Z0

sin klg cos klg

][
1 0
1
Zb

1

]
[

cos kl2 jZ2 sin kl2
j
Z2

sin kl2 cos kl2

]{
p6

v6

} (2.7)

Transmission loss of EIEO chamber becomes infinity if Za and Zb tend to zero. This happens when

kla = (2m− 1)π/2 and klb = (2n− 1)π/2 (2.8)

where m and n are integers (m, n = 1, 2, 3 . . . )

This property can be used to cancel out some of the troughs in the TL curve of SEC. It can be

shown that [19] if la = l/2 then troughs 1, 3, 5, 7 . . . and so on would be canceled out, and if lb = l/4

then troughs 2, 6, 10, 14 . . . and so on would be nullified. This is shown in Fig. 2.5. Thus except

4, 8, 12, . . . all the troughs are tuned. Also, the overall TL curve has been lifted. This is the basic

principle of an EIEO chamber.

2.2 Formulation for optimized design

It is important to study fluid flow behaviour in an Extended Inlet Extended Outlet muffler to reduce

the pressure loss between two ends. An EIEO muffler with dimensions D = 153 mm, d1 = d2 =

48.59 mm is considered for flow analysis. An axial velocity of 10 m/s is given as inlet condition.
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Figure 2.6: Normalized jet height w.r.t. velocity ratio at different axial locations in SEC muffler

Table 2.1 gives the details of the computational model and boundary conditions used for numerical

simulation. [11].

Table 2.1: Computational model details and boundary conditions

Sr. No. Solution Variables
1. Model K-ε Turbulence
2. Solver Axisymmetric, 2nd Order implicit
3. Pressure-Velocity coupling PISO
4. Discretization technique Second Order UPWIND
5. Fluid Air(Ideal)
6. Operating Pressure 101325 Pa

Boundary Conditions
7. Inlet velocity 10 m/s
8. Outlet gauge pressure 0 Pa
9. Turbulent Intensity 3%
10. Hydraulic Diameter Diameter of inlet/outlet pipe

Velocity ratio is defined as a ratio of velocity at a particular position to the mean flow velocity of

the jet (U/U0). It is symbolized as q and is decided based on allowable back pressure. Fig. 2.6

represents velocity ratio U/U0 in a non-dimensional form and normalized jet height dimensions with

respect to axial positions y/x. Axial location x is normalized with pipe diameter d which can be

used to describe the required core jet formation length x/d. Higher values of x/d means longer core

jet length, and these values are varied from 0.25 to 1.5 in the current study. It is observed that

the potential core is decreasing with the axial distance. For designing the extended pipe length,

one needs to fix the U/U0 value and y value to get an axial dimension x. Fig. 2.6 is redrawn for a

constant velocity ratio q and it provides relationship between x/d and y/x. A simple representation
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is assumed for x/d and y/x as C1 and C2, respectively. C1 and C2 are called as characteristic

parameters.

For different values of L/D, flow curves are plotted as C2 vs C1. C1 and C2 are called as characteristic

parameters. As shown in Fig. 2.7, y is the radial distance from the centre axis whereas x is the axial

length. It is proposed to keep y constant for a given inlet jet speed q for x varying from 0 to L/D.

This will ensure that a maximum portion of the fluid jet is passed on to the extended outlet with

very less or without expansion in the chamber of a muffler. For this ideal case, it is assumed that

the jet diameter is same as diameter of the extended lengths (i.e. y = d/2). The ideal equation can

be written as:

C1C2 = 0.5 (2.9)

The relationship between characteristic parameters C1 and C2 is expressed in a generalised form of

equations as:

C2 = aC−b1 (2.10)

where a and b are constants for a particular L/D ratio.

Figure 2.7: Representation of terminology for C1 vs C2 curves

Practically, it is not possible to get the jet core diameter as d. Thus y = g × d is considered, where

g is the ratio of jet core radius to inlet diameter and it is less than 0.5. Flow simulation data is

collected for velocity ratios from q = 0.5 up to q = 0.9 and the constants a and b are determined

as functions of q. Fig. 2.8 shows the curve equations for the constants a and b as functions of

velocity ratio for different L/D. To find a more generalized equation, these constants are assumed

as functions of parameter L/D. The generalized equation obtained is:

C2 = [Aq +B]× C [Eq2+Fq+G]
1 (2.11)

where A, B, E, F and G are functions of L/D.

The back pressure is minimized by avoiding flow expansion inside the chamber. It is achieved with

jet height dimensions as close as possible to the radius of extended inlet and outlet pipe. So it leads

to a condition as:

C2 ≥ C2(ideal) (2.12)
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Figure 2.8: Empirically formulated curves for constants a and b

Using Eqs. 2.10 and 2.12, the constraint to be satisfied is obtained as:

x ≥ lg (2.13)

Eq. 2.11 was used to find values of C2 for available simulation parameters i.e. C1, q and L/D. A

MATLAB® code [20] was written to do a regression fit analysis and a linear model with regression

coefficient R2 = 0.975 was obtained as:

C2 = −0.1426 + 0.55886C1 − 0.02843q + 0.037828

(
L

D

)
(2.14)

2.3 Results

A regression analysis was implemented for the one-dimensional study of EIEO muffler. Eq. 2.14

was obtained as a linear fit equation. It was used to estimate the maximum core jet length xmax

and then compared with acoustic gap length lg.

Table 2.2: Comparison between acoustic gap length lg and maximum core jet length xmax

L/D Ratio la (mm) lb (mm) lg (mm) xmax (mm)
0.5 21.4 6.4 32.2 41.6
1.0 51.4 21.4 47.2 40.9
1.5 81.4 36.4 62.2 40.1
2.0 111.4 51.4 77.2 39.4
2.5 141.4 66.4 92.2 38.6

An EIEO muffler with dimensions of d = 40 mm, D = 120 mm, q = 0.9 and g = 0.45 was considered

for the study. The required acoustic gap length lg was calculated using the end correction. The

expression for end correction is given as [7]:

δ

d
= a0 + a1

(
D

d

)
+ a2

(
tw
d

)
+ a3

(
D

d

)2

+ a4

(
D

d

tw
d

)
+ a5

(
tw
d

)2

(2.15)
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where a0=0.005177, a1=0.0909, a2=0.537, a3=-0.008594, a4=0.002616, a5=-5.425; d and tw are

diameter and wall thickness of the extended inlet and outlet.

The acoustic gap length was then compared with the maximum core jet length xmax for a given

velocity ratio.
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Figure 2.9: Variation of acoustic gap length and maximum core jet length

The lg and xmax values for different L/D ratios are given in Table 2.2. These results are presented

in graphical form in Fig. 2.9. If lg is less than xmax, a jet core is formed between the inlet and outlet

extensions of the muffler. It is evident from this study that the jet formation concept to reduce back

pressure is ideal for short chamber EIEO muffler design.
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Chapter 3

Three-dimensional analysis

As discussed in Chapter 2, one-dimensional analysis is used to analyze the performance of EIEO

muffler. But, as transverse mode propagation is significant in short chamber length mufflers, a three-

dimensional analysis is required for estimating the transmission loss characteristics. The EIEO

muffler can be considered as a combination of annular and circular cavities. The literature for

circular cavities already exists [13]. The methodology for calculating the transmission loss of an

annular cavity is discussed in this chapter.

The step-by-step procedure involves the following steps:

• Mode shape function

• Green’s function derivation

• Velocity potential

• Piston analogy approach

• Four pole parameters

• Calculation of transmission loss

3.0.1 Mode shape function

The three-dimensional homogeneous wave equation [13] is given as:

∇2P − 1

c2
∂2P

∂t2
= 0 (3.1)

The above equation is solved by using separation of variables. The basic idea behind this technique

is to assume, initially, that the variable of interest can be separated into factors which depend

separately on the coordinates. The above differential equation can be solved by assuming a solution

in the cylindrical co-ordinate system as:

P (r, θ, z, t) = R (r) Θ (θ)Z (z) ejωt (3.2)

Substituting Eq. 3.2 in 3.1, we get

R′′

R
+

1

r

R′

R
+

1

r2

Θ′′

Θ
+
Z ′′

Z
+
ω2

c2
= 0 (3.3)
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Since the Θ function has to satisfy continuity condition, it takes the form of trigonometric cosine

function.

Θ (θ) = cos (mθ − α) (3.4)

where α is an arbitrary angle.

Therefore,
Θ′′

Θ
= −m2 (3.5)

Substituting in Eq. 3.3,
R′′

R
+

1

r

R′

R
− m2

r2
+
Z ′′

Z
+
ω2

c2
= 0 (3.6)

Rewriting Eq. 3.6 as a function of r and z only,(
R′′

R
+

1

r

R′

R
− m2

r2

)
+

(
Z ′′

Z

)
= −ω

2

c2
(3.7)

Now, the differential equation has been separated into a sum of two differential equations, each of

which depend on a different variable. Making a substitution for function Z as given below, it is

simplified as:
Z ′′

Z
= −k 2

zp (3.8)

Boundary conditions used for z co-ordinate are:

d

dz
Z(z)

∣∣∣∣
z=0

= 0,
d

dz
Z(z)

∣∣∣∣
z=L

= 0 (3.9)

Solving Eq. 3.8 we get

sin (kzpL) = 0 (3.10)

Therefore,

kzpL = pπ i.e. kzp =
pπ

L
(p = 0, 1, 2 . . . ) (3.11)

Thus, the solution for Z is given as:

Z (z) = cos
(pπz
L

)
(3.12)

The wavenumber is given by Eq. 3.13

k2 =
ω2

c2
(3.13)

Substituting Eqs. 3.8 and 3.13 in Eq. 3.7, we get

r2R′′ + rR′ +

[(
k2 − p2π2

L2

)
r2 −m2

]
R = 0 (3.14)

Solution of Eq. 3.14 is given by making use of Bessel functions as below.

R (r) = AmJm (κr) +BmYm (κr) (3.15)
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where

κ =

√(
k2 − p2π2

L2

)
(3.16)

Function R will be equal to 0 at the inner radius (a/2) and the outer radius (b/2). Thus, the

boundary conditions for function R can be written as:

d

dr
R (r)

∣∣∣∣
r=a/2

= 0
d

dr
R (r)

∣∣∣∣
r=b/2

= 0 (3.17)

Applying the above boundary conditions to Eq. 3.15

J ′m

(κa
2

)
Y ′m

(
κb

2

)
− J ′m

(
κb

2

)
Y ′m

(κa
2

)
= 0 (3.18)

Eq. 3.18 can be rewritten as follows using the recurrence relationship for Bessel functions.

[
mJm

(κa
2

)
− κa

2
Jm+1

(κa
2

)] [
mYm

(
κb

2

)
− κb

2
Ym+1

(
κb

2

)]
−
[
mYm

(κa
2

)
− κa

2
Ym+1

(κa
2

)] [
mJm

(
κb

2

)
− κb

2
Jm+1

(
κb

2

)]
= 0

(3.19)

Different values of m are used to find the roots of Eq. 3.19. For selected values of m, a κ is sought

for, which satisfies the above equation. There will be an infinite number of them. Each value is

designated as κmn, where n = 0, 1, 2 . . .

The natural frequencies are then obtained from Eq. 3.20.

ωmnp = c
√
κ 2
mn + k 2

zp (3.20)

The mode function R thus becomes:

R (r) = Jm (κmnr) + CmnYm (κmnr) (3.21)

where

Cmn =

[
mJm

(
κmna

2

)
− κmna

2 Jm+1

(
κmna

2

)][
mYm

(
κmna

2

)
− κmna

2 Ym+1

(
κmna

2

)] (3.22)

Thus, two sets of mutually independent natural modes can be used for determination of mode shapes.

This is done by considering the Θ function as cos θ and sin θ. This gives the following two mode

shape functions which are obtained from Eqs. 3.4, 3.12 and 3.21.

Pmnp(1) (r, θ, z) = [Jm (κmnr) + CmnYm (κmnr)] cos(mθ) cos
(pπz
L

)
Pmnp(2) (r, θ, z) = [Jm (κmnr) + CmnYm (κmnr)] sin(mθ) cos

(pπz
L

) (3.23)

3.0.2 Green’s function derivation

A Green’s function is the impulse response of an inhomogeneous differential equation defined on a

domain, with specified initial conditions or boundary conditions. The acoustic wave equation for

arbitrary space which has distributed sources Q(~r) can be represented in terms of velocity potential
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φ (r) as [21]:

∇2φ+ k2φ = Q (~r) (3.24)

Thus acoustic pressure is:

p(~r, t) = −ρ∂φ(~r, t)

∂t
= −ρjωφ(~r) (3.25)

and particle velocity:

u(~r) = gradφ(~r) = ∇φ(~r) (3.26)

The acoustic field for the whole space can be obtained by superposition principle. That is, if G (~r|~r0)

is the field at the observer point ~r caused by a unit point source ~r0, it is governed by:

∇2G (~r|~r0) + k2G (~r|~r0) = δ3 (~r − ~r0) (3.27)

We assume that the eigenfunctions Ψmnp (~r) form a single set. Thus the Green’s function can be

expressed in a series of Ψmnp (~r), satisfying the homogeneous boundary conditions [21].

G (~r|~r0) = 4π
∑
mnp

Ψ̄mnp (~r) ·Ψmnp (~r0)

k2
mnp − k2

(3.28)

The mode shape of an annular cavity is given as:

Ψmnp (~r) = [Jm (κmnr) + CmnYm (κmnr)] cos(mθ) cos
(pπz
L

)
(3.29)

and the corresponding wavenumber is:

kmnp =
[
κmn

2 + kzp
2
]1/2

(3.30)

The orthonormal function Ψ̄mnp (~r) is written as:

Ψ̄mnp (~r) = (ereθez)
−1
Ψmnp (~r) (3.31)

Here, r and r0 are the response vector and source vector respectively; m, n and p are integers; er,

eθ and ez are known as normalizing factors. They are as follows:

er =

∫ b/2

a/2

r [Jm (κmnr) + CmnYm (κmnr)]
2
dr (3.32)

eθ =

∫ 2π

0

[cos (mθ)]
2
dθ (3.33)

ez =

∫ L

0

[
cos
(pπz
L

)]2
dz (3.34)

The expression for er can be calculated using Mathematica as [22]:

er =er1 + er2 + er3

=

∫ b
2

a
2

rJm (κmnr)
2 dr + er2 + C2

mn

∫ b
2

a
2

rYm (κmnr)
2 dr

(3.35)
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The integral solution of er1 and er3 can be obtained easily.

er1 =
1

8κmn

(
b

(
bκmn

(
Jm−1

(
bκmn

2

)
2 + Jm

(
bκmn

2

)
2

)
− 4mJm−1

(
bκmn

2

)
Jm

(
bκmn

2

)))
− 1

8κmn

(
a
(
aκmn

(
Jm−1

(aκmn
2

)
2 + Jm

(aκmn
2

)
2
)
− 4mJm−1

(aκmn
2

)
Jm

(aκmn
2

)))
(3.36)

er3 =
Cmn

2

8κmn

(
b

(
bκmn

(
Ym−1

(
bκmn

2

)
2 + Ym

(
bκmn

2

)
2

)
− 4mYm−1

(
bκmn

2

)
Ym

(
bκmn

2

)))
−Cmn

2

8κmn

(
−a
(
aκmn

(
Ym−1

(aκmn
2

)
2 + Ym

(aκmn
2

)
2
)
− 4mYm−1

(aκmn
2

)
Ym

(aκmn
2

)))
(3.37)

The integral er2 can be evaluated numerically as no complete solution can be obtained for it. Math-

ematica [22] is used to evaluate this integral.

The integrals eθ and ez are calculated as:

eθ =

2π, m = 0,

π, otherwise

ez =

2L, p = 0,

L, otherwise

The Green’s function can be obtained by substituting Eqs. 3.31, 3.32, 3.33 and 3.34 in Eq. 3.28

G (~r|~r0) = 4π
∑
mnp

Gmnp(k)Ψmnp (~r)Ψmnp (~r0) (3.38)

where

Gmnp(k) =
(ereθez)

−1

kmnp
2 − k2

(3.39)

Ψmnp (~r) = [Jm (κmnr) + CmnYm (κmnr)] cos(mθ) cos
(pπz
L

)
(3.40)

Ψmnp (~r0) = [Jm (κmnr0) + CmnYm (κmnr0)] cos(mθ0) cos
(pπz0

L

)
(3.41)

3.1 Side-Inlet-Side-Outlet (SISO) configuration

As seen in Fig. 3.1, the surfaces of the annular cavity are defined as SA, SB and SC . The inlet port

is located on surface SA at a distance l1 from surface SB and at 0°. The outlet port is at a distance

l2 and at 180°. Both the ports are of elliptical cross-section. The half major axis length is a1 and

a2 whereas the half minor axis length is b1 and b2 for the inlet and outlet ports respectively. The

hypothetical velocities of pistons at the inlet and outlet ports are assumed as u1 and u2 respectively.
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𝑑𝑑𝑖𝑖

SB

SA SC

Port 1 (𝜃𝜃1= 0°)
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𝑙𝑙1

𝑙𝑙2

Figure 3.1: Annular cavity with Side-Inlet-Side-Outlet configuration

The boundary conditions on the surfaces of the annular cavity can be defined as follows:

SA :
∂φ

∂r

∣∣∣∣
r=b/2

= u1 cos θ1f1 (z, θ) + u2 cos θ2f2 (z, θ) = N1 (z, θ) +N2 (z, θ) (3.42)

SB :
∂φ

∂z

∣∣∣∣
z=0

= 0 (3.43)

SC :
∂φ

∂z

∣∣∣∣
z=L

= 0 (3.44)

3.1.1 Velocity potential

Assuming harmonic behaviour, the velocity potential may be written as φ(~r, t) = φ(~r)ejωt.

Total velocity potential inside the chamber is expressed by superimposing the velocity potentials

generated due to the inlet and outlet piston sources. Thus, the expression for total velocity potential

can be written as:

φ(~r) = − 1

4π

∫∫
G (~r|~r0)N(rS0 )dS0

= − 1

4π

[∫∫
G (~r|~r0)N1 (z, θ) dSA +

∫∫
G (~r|~r0)N2 (z, θ) dSA

] (3.45)

Let us assume:

φ1(~r) = − 1

4π

∫∫
port 1

G (~r|~r0)N1 (z, θ) dSA (3.46)

φ2(~r) = − 1

4π

∫∫
port 2

G (~r|~r0)N2 (z, θ) dSA (3.47)
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The velocity potential caused by port 1 can be obtained by substituting Green’s function (3.38) into

Eq. 3.46

φ1(~r) = (−)
1

4π

∫∫
4π
∑
mnp

Gmnp(k)Ψmnp (~r)Ψmnp (~r0)N1 (z, θ) dSA

= (−)
∑
mnp

Gmnp(k)Ψmnp (~r)

∫∫
Ψmnp (~r0)u1 cos θ1f1 (z, θ) dSA

= (−)
∑
mnp

Gmnp(k)Ψ (1)
mnp(~r)u1x1

(3.48)

where Ψ
(1)
mnp(~r) is the mode shape function corresponding to port 1.

Ψ (1)
mnp(~r) =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(mθ1) cos (kzpl1) (3.49)

and,

x1 =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]∫∫
port 1

cos(θ) cos (mθ) cos (kzpz) dSA

= πa1b1

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(kzpl1)[

Fmp

(
1

2
, cos[(m− 1)θ1]× J1(b2βm−1,1)

b2βm−1,1

)
+ cos[(m− 1)θ1]× J1(b1βm+1,1)

b1βm+1,1

] (3.50)

The evaluation of the above integral is explained in Appendix A.1.

Similarly, the velocity potential for piston 2 can be written as:

φ2(~r) = (−)
∑
mnp

Gmnp(k)Ψ (2)
mnp(~r)u2x2 (3.51)

where Ψ
(2)
mnp(~r) is the mode shape function corresponding to port 2.

Ψ (2)
mnp(~r) =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(mθ2) cos (kzpl2) (3.52)

and,

x2 =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]∫∫
port 2

cos(θ) cos (mθ) cos (kzpz) dSA

= πa2b2

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(kzpl2)[

Fmp

(
1

2
, cos[(m− 1)θ2]× J1(b2βm−1,2)

b2βm−1,2

)
+ cos[(m− 1)θ2]× J1(b2βm+1,2)

b2βm+1,2

] (3.53)

The evaluation of the above integral is explained in Appendix A.1.
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3.1.2 Piston analogy approach

The equations for derived velocity potentials in the above section are used to estimate the four

pole parameters of the transfer matrix. It is further used to evaluate the transmission loss, which

expresses the performance of the cavity.

The average sound pressure acting on piston i with cross-sectional area Ai caused by the velocity

field which is generated by elliptic piston j, can be written as:

p̄ij = (−)
jωρ

Ai

∫∫
piston i

φj(~r)dSi = viEij (3.54)

where vi is the volume velocity; vi = Aiui.

If the geometry of the ports is identical, then Ai = Aj , implying Eij = Eji, which shows that these

values are independent of inlet and outlet port positions. Hence, the reciprocity relation is satisfied.

Accordingly, the total sound pressure acting on the inlet and outlet ports can be expressed as:

p̄1 = p̄11 + p̄12 = v1E11 + v2E12 (3.55)

p̄2 = p̄21 + p̄22 = v1E21 + v2E22 (3.56)

According to Eq. 3.54, the average sound pressure acting on output piston 2 due to input piston 1

can be written as:

p̄21 (~r) = (−)
jωρ

A2

∫
piston 2

φ1 (~r) dS2

= (−)
jωρ

A2

∫
piston 2

(−)
∑
mnp

Gmnp (k)u1x1Ψ
(1)
mnp (~r) dS2

=
jωρ

A2

∑
mnp

Gmnp (k)u1x1y2

(3.57)

where

y2 =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]∫∫
port 2

cos (mθ) cos (kzpz) dSA

= 2πa2b2

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(kzpl2) cos(mθ2)Qmp

(
1

2
,
J1(b2βm,2)

b2βm,2

) (3.58)

The solution for the above integral has been explained in Appendix A.2

Thus, the E-function E21 can be written as:

E21 =
p̄21 (~r)

A1u1
=

jωρ

A1A2

∑
mnp

Gmnp (k) y2x1 (3.59)

Similarly,

E11 =
p̄11 (~r)

A1u1
=
jωρ

A1
2

∑
mnp

Gmnp (k) y1x1 (3.60)
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E12 =
p̄12 (~r)

A2u2
= (−)

jωρ

A1A2

∑
mnp

Gmnp (k) y1x2 (3.61)

E22 =
p̄21 (~r)

A2u2
= (−)

jωρ

A2
2

∑
mnp

Gmnp (k) y2x2 (3.62)

3.1.3 Four pole parameters

The transfer matrix relating the acoustic state variables at the inlet and outlet is written as:{
p̄1

v1

}
=

[
T11 T12

T21 T22

]{
p̄2

v2

}
(3.63)

where, p̄1 and p̄2 are acoustic pressures; v1 and v2 are volume velocities at the inlet and the outlet

respectively.

Using Eqs. 3.55 and 3.56 the four pole parameters Tij can be written in terms of E-functions as

follows:

T11 =

∣∣∣∣ p̄1

p̄2

∣∣∣∣
v2=0

=
E11

E21
(3.64)

T12 =

∣∣∣∣ p̄1

v2

∣∣∣∣
p̄2=0

=

(
E12 −

E11E22

E21

)
(3.65)

T21 =

∣∣∣∣v1

p̄2

∣∣∣∣
v2=0

= (E21)
−1

(3.66)

T22 =

∣∣∣∣v1

v2

∣∣∣∣
p̄2=0

= (−)
E22

E21
(3.67)

3.1.4 Calculation of transmission loss

The transmission loss can be expressed in terms of four pole parameters as:

TL = 20 log10


(
Z2

Z1

)1/2
∣∣∣∣∣∣
T11 + T12

Z2
+ T21Z1 + T22

(
Z1

Z2

)
2

∣∣∣∣∣∣
 (3.68)

where Z1 is the acoustic impedance of the inlet, Z2 is the acoustic impedance of the outlet.

3.2 Face-Inlet-Face-Outlet (FIFO) configuration

As seen in Fig. 3.2, the surfaces of the annular cavity are defined as SA, SB and SC . The inlet

port is located on surface SB at a distance δ from the z axis at 0°. Both the ports are of elliptical

cross-section. The half major axis length is a1 and a2 whereas the half minor axis length is b1 and

b2 for the inlet and outlet ports respectively. The outlet port is on the surface SC , also at a distance

δ and at 180°. The hypothetical velocities of pistons at the inlet and outlet ports are assumed as u1

and u2 respectively.
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Figure 3.2: Annular cavity with Face-Inlet-Face-Outlet configuration

The boundary conditions on the surfaces of the annular cavity can be defined as follows:

SA :
∂φ

∂r

∣∣∣∣
r=b/2

= 0 (3.69)

SB :
∂φ

∂z

∣∣∣∣
z=0

= u1f1(r, θ) = N1(r, θ) (3.70)

SC :
∂φ

∂z

∣∣∣∣
z=L

= u2f2(r, θ) = N2(r, θ) (3.71)

3.2.1 Velocity potential

Assuming harmonic behaviour, the velocity potential may be written as φ(~r, t) = φ(~r)ejωt.

Total velocity potential inside the chamber is expressed by superimposing the velocity potentials

generated due to the inlet and outlet piston sources. Thus, the expression for total velocity potential

can be written as:

φ(~r) = − 1

4π

∫∫
G (~r|~r0)N(rS0 )dS0

= − 1

4π

[∫∫
G (~r|~r0)N1 (r, θ) dSB +

∫∫
G (~r|~r0)N2 (r, θ) dSC

] (3.72)

Let us assume:

φ1(~r) = − 1

4π

∫∫
port 1

G (~r|~r0)N1 (r, θ) dSB (3.73)

φ2(~r) = − 1

4π

∫∫
port 2

G (~r|~r0)N2 (r, θ) dSC (3.74)
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The velocity potential caused by port 1 can be obtained by substituting Green’s function (3.38) into

Eq. 3.73

φ1(~r) = (−)
1

4π

∫∫
4π
∑
mnp

Gmnp(k)Ψmnp (~r)Ψmnp (~r0)N1 (r, θ) dSB

= (−)
∑
mnp

Gmnp(k)Ψmnp (~r)

∫∫
Ψmnp (~r0)u1f1 (r, θ) dSB

= (−)
∑
mnp

Gmnp(k)Ψ (1)
mnp(~r)u1x1

(3.75)

where Ψ
(1)
mnp(~r) is the mode shape function corresponding to port 1.

Ψ (1)
mnp(~r) =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(mθ1) cos (kzpl1) (3.76)

and,

x1 =

∫∫
port 1

Jm(κmnr) cos(mθ)f1(r, θ)rdrdθ

=
2πa1

2

(κmna1 + 2µmn)
(J1 (κmna1) + µmn) Jm (κmnδ) cos (mθ1) cos (kzpl1)

(3.77)

Similarly, the velocity potential for piston 2 can be written as:

φ2(~r) = (−)
∑
mnp

Gmnp(k)Ψ (2)
mnp(~r)u2x2 (3.78)

where Ψ
(2)
mnp(~r) is the mode shape function corresponding to port 2.

Ψ (2)
mnp(~r) =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(mθ2) cos (kzpl2) (3.79)

and,

x2 =

∫∫
port 2

Jm(κmnr) cos(mθ)f2(r, θ)rdrdθ

=
2πa2

2

(κmna2 + 2µmn)
(J1 (κmna2) + µmn) Jm (κmnδ) cos (mθ2) cos (kzpl2)

(3.80)

The solution for integration over the port area has been explained in Appendix A.3

3.2.2 Piston analogy approach

As described in Sec. 3.1.2, the average sound pressure acting on output piston 2 due to input piston

1 can be written as:
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p̄21 (~r) = (−)
jωρ

A2

∫
piston 2

φ1 (~r) dS2

= (−)
jωρ

A2

∫
piston 2

(−)
∑
mnp

Gmnp (k)u1x1Ψ
(1)
mnp (~r) dS2

=
jωρ

A2

∑
mnp

Gmnp (k)u1x1x2

(3.81)

Thus, the E-function E21 can be written as:

E21 =
p̄21 (~r)

A1u1
=

jωρ

A1A2

∑
mnp

Gmnp (k)x2x1 (3.82)

Similarly,

E11 =
p̄11 (~r)

A1u1
=
jωρ

A1
2

∑
mnp

Gmnp (k)x1
2 (3.83)

E12 =
p̄12 (~r)

A2u2
= (−)

jωρ

A1A2

∑
mnp

Gmnp (k)x1x2 (3.84)

E22 =
p̄21 (~r)

A2u2
= (−)

jωρ

A2
2

∑
mnp

Gmnp (k)x2
2 (3.85)

3.2.3 Four pole parameters

The four pole parameters can be estimated in the same way as described in Sec. 3.1.3

3.2.4 Calculation of transmission loss

The transmission loss can be estimated in a similar way as described in Sec. 3.1.4

3.3 Face-Inlet-Side-Outlet (FISO) configuration

As shown in Fig. 3.3, the surfaces of the annular cavity are defined as SA, SB and SC . The inlet

port is located on surface SB at a distance δ from the z axis at 180°. The outlet port is on the

curved surface SA, and is at a distance l2 at 0°from surface SB . Both the ports are of elliptical

cross-section. The half major axis length is a1 and a2 whereas the half minor axis length is b1 and

b2 for the inlet and outlet ports respectively. The hypothetical velocities of pistons at the inlet and

outlet ports are assumed as u1 and u2 respectively as shown in the diagram.
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Figure 3.3: Annular cavity with Face-Inlet-Side-Outlet configuration

The boundary conditions on the surfaces of the annular cavity can be defined as follows:

SA :
∂φ

∂r

∣∣∣∣
r=b/2

= u2 cos θ2f2(z, θ) = N2(z, θ) (3.86)

SB :
∂φ

∂z

∣∣∣∣
z=0

= u1f1(r, θ) = N1(r, θ) (3.87)

SC :
∂φ

∂z

∣∣∣∣
z=L

= 0 (3.88)

3.3.1 Velocity potential

Assuming harmonic behaviour, the velocity potential may be written as φ(~r, t) = φ(~r)ejωt.

Total velocity potential inside the chamber is expressed by superimposing the velocity potentials

generated due to the inlet and outlet piston sources. Thus, the expression for total velocity potential

can be written as:

φ(~r) = − 1

4π

∫∫
G (~r|~r0)N(rS0 )dS0

= − 1

4π

[∫∫
G (~r|~r0)N1 (r, θ) dSB +

∫∫
G (~r|~r0)N2 (z, θ) dSA

] (3.89)

Let us assume:

φ1(~r) = − 1

4π

∫∫
port 1

G (~r|~r0)N1 (r, θ) dSB (3.90)

φ2(~r) = − 1

4π

∫∫
port 2

G (~r|~r0)N2 (z, θ) dSA (3.91)
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The velocity potential caused by port 1 can be obtained by substituting Green’s function (3.38) into

Eq. 3.90

φ1(~r) = (−)
1

4π

∫∫
4π
∑
mnp

Gmnp(k)Ψmnp (~r)Ψmnp (~r0)N1 (r, θ) dSB

= (−)
∑
mnp

Gmnp(k)Ψmnp (~r)

∫∫
Ψmnp (~r0)u1f1 (r, θ) dSB

= (−)
∑
mnp

Gmnp(k)Ψ (1)
mnp(~r)u1x1

(3.92)

where Ψ
(1)
mnp(~r) is the mode shape function corresponding to port 1.

Ψ (1)
mnp(~r) =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(mθ1) cos (kzpl1) (3.93)

and,

x1 =

∫∫
port 1

Jm(κmnr) cos(mθ)f1(r, θ)rdrdθ

=
2πa1

2

(κmna1 + 2µmn)
(J1 (κmna1) + µmn) Jm (κmnδ) cos (mθ1) cos (kzpl1)

(3.94)

Similarly, the velocity potential for piston 2 can be written as:

φ2(~r) = (−)
1

4π

∫∫
4π
∑
mnp

Gmnp(k)Ψmnp (~r)Ψmnp (~r0)N2 (z, θ) dSA

= (−)
∑
mnp

Gmnp(k)Ψmnp (~r)

∫∫
Ψmnp (~r0)u2 cos θ2f2 (z, θ) dSA

= (−)
∑
mnp

Gmnp(k)Ψ (2)
mnp(~r)u2y2

(3.95)

where Ψ
(2)
mnp(~r) is the mode shape function corresponding to port 2.

Ψ (2)
mnp(~r) =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(mθ2) cos (kzpl2) (3.96)

and,

y2 =

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]∫∫
port 2

cos (mθ) cos (kzpz) dSA

= πa2b2

[
Jm

(
κmnb

2

)
+ CmnYm

(
κmnb

2

)]
cos(kzpl2)

[
Fmp

(
1

2
, cos[(m− 1)θ2]× J1(b2βm−1,2)

b2βm−1,2

)
+ cos[(m− 1)θ2]× J1(b2βm+1,2)

b2βm+1,2

] (3.97)
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3.3.2 Piston analogy approach

The average sound pressure acting on input piston 1 due to input piston 1 can be derived using the

same formulation as described in Sec. 3.1.2.

p̄11 (~r) = (−)
jωρ

A1

∫
piston 1

φ1 (~r) dS1

= (−)
jωρ

A1

∫
piston 1

(−)
∑
mnp

Gmnp (k)u1x1Ψ
(1)
mnp (~r) dS1

=
jωρ

A1

∑
mnp

Gmnp (k)u1x1
2

(3.98)

Thus, the E-function E11 can be written as:

E11 =
p̄11 (~r)

A1u1
=
jωρ

A1
2

∑
mnp

Gmnp (k)x1
2 (3.99)

Similarly, the sound pressure p̄21 (~r) can be derived as:

p̄21 (~r) = (−)
jωρ

A2

∫
piston 2

φ1 (~r) dS2

= (−)
jωρ

A2

∫
piston 2

(−)
∑
mnp

Gmnp (k)u1x1Ψ
(1)
mnp (~r) dS2

=
jωρ

A2

∑
mnp

Gmnp (k)u1x1y2

(3.100)

The corresponding E-function is

E21 =
p̄21 (~r)

A1u1
=

jωρ

A1A2

∑
mnp

Gmnp (k)x1y2 (3.101)

Similarly,

E12 =
p̄12 (~r)

A2u2
= (−)

jωρ

A1A2

∑
mnp

Gmnp (k)x1y2 (3.102)

E22 =
p̄21 (~r)

A2u2
= (−)

jωρ

A2
2

∑
mnp

Gmnp (k) y2
2 (3.103)

3.3.3 Four pole parameters

The four pole parameters can be estimated in the same way as described in Sec. 3.1.3

3.3.4 Calculation of transmission loss

The transmission loss can be calculated from Sec. 3.1.4
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Chapter 4

Finite element analysis

4.1 Introduction to FEA

Finite element analysis (FEA) also known as finite element method (FEM) is one of the most com-

mon method in practice. A large and complex system, which is governed by a partial differential

equation(s) is broken down into a discrete system of algebraic linear equations. These linear equa-

tions represent the behaviour of the discretised portions of the system, known as elements. Smaller

the element area of the system, more accurate will the model be. The simple equations that model

these finite elements are then assembled together to model the entire system. The general form of

the consequent linear equations is usually represented as [K]{u} = {F}. Generally, a structure is

divided into several hundred elements, generating a very large number of equations that can only

be solved with the help of a computer.

The term finite element stems from the procedure in which a structure is divided into small but

finite size elements (as opposed to an infinite size, generally used in mathematical integration). The

endpoints or corner points of the element are called nodes. Each element possesses its own geometric

and elastic properties. Spring, Truss, and Beams elements, called line elements, are usually divided

into small sections with nodes at each end. Plane and solid elements require more than two nodes

and can have over 8 nodes for a 3 dimensional element.

A line element has an exact theoretical solution, e.g., truss and beam elements are governed by

their respective theories of deflection. But when it comes to complex engineering systems with

stress concentration points like holes and other discontinuities, it becomes impossible to use stan-

dard equations. This is where the finite element method comes into picture.The following section

explains the use of ’LMS Virtual.Lab’ to estimate the transmission loss of the annular cavity.

4.2 LMS Virtual.Lab

LMS Virtual.Lab is a software which integrates 3D FEM and multi-body simulation and optimizes

the performance of mechanical systems for structural integrity, noise and vibration, system dynamics

and durability.

LMS Virtual.Lab Finite Element Acoustics offers an advanced method for predicting and improving

the noise and sound performance of a broad range of systems.
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The major steps involved in performing a 3D FEM simulation on this software are:

• Creating a CAD model

• Meshing the model

• Importing the model in LMS Virtual.Lab

• Assigning proper boundary conditions

• Post-processing the results

• Calculation of transmission loss

4.2.1 Creating a CAD model

The CAD model is a geometrical representation of the flow domain inside the annular muffler cavity.

Different types of CAD software can be used to create the model according to ease to the user.

Figure 4.1: CAD geometry of Face-Inlet-Side-Outlet (FISO) annular cavity

Fig. 4.1 shows the geometry of an annular cavity with Face-Inlet-Side-Outlet configuration. ANSYS

Workbench was used to create the geometry. The geometry depicts the volume which will be used

for simulation.

4.2.2 Meshing the model

Meshing is probably the most important part in any of the computer simulations, because it can

show drastic changes in the obtained results. Meshing simply means creating a mesh of some grid-

points called ’nodes’. It is done with a variety of tools and options available in the software. The
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results are calculated by solving the relevant governing equations numerically at each of the nodes

of the mesh. The governing equations are almost always partial differential equations. The pattern

and relative positioning of the nodes also affect the solution, computational efficiency and time. This

is why good meshing is very essential for a computer simulation to give satisfactory results.

Figure 4.2: Tetrahedral Mesh Figure 4.3: Hexahedral Mesh

Fig. 4.2 shows a tetrahedral mesh created using the meshing module of ANSYS®Workbench. A

tetrahedral mesh being an unstructured mesh, can be created easily. Although, it is computationally

expensive as it takes more time for simulation.

An hexahedral mesh is shown in Fig. 4.3. It consists of hexahedrons which are arranged in regular

patterns across the whole volume. This type of mesh can be easily created for simple pre-defined

geometry shapes. But when it comes to complex geometries, it takes some manipulations thus

consuming more time. An hexahedral mesh is a structured mesh. Hence, it is computationally

better than a tetrahedral mesh as solving the linear equations becomes much easier and faster.

4.2.3 Importing the model in LMS Virtual.Lab

After creating the meshed model, it can be imported into the software in various compatible formats

such as .cdb, .nas, .stp, etc.

4.2.4 Assigning proper boundary conditions

After importing the model into the software, materials and properties for the flow domain are defined.

In case of a muffler cavity, an inlet and outlet is defined for the sound wave propagation. A unit

velocity of 1 m/s is applied as the inlet boundary condition while the outlet is considered as anechoic

termination.

4.2.5 Post-processing the results

After the simulation is complete, the acoustic pressure values at the inlet and outlet are estimated

by the software for the specified frequency range.
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4.2.6 Calculation of transmission loss

The transmission loss can be estimated in two different ways:

1. Exporting the acoustic pressure data from the software into a Microsoft®Excel file.

The acoustic pressure comprises of the real and imaginary component. Both components of the

inlet and outlet acoustic pressures are exported and transmission loss is calculated according

to the formula as:

TL = 20 log10

∣∣∣∣Pin + ρcVin
2Pout

∣∣∣∣ (4.1)

where Pin is the acoustic pressure at the inlet, Pout is the acoustic pressure at the outlet, Vin

is the velocity at the inlet (1 m/s)

2. Post-processing the acoustic pressure data in the software itself.

The detailed procedure regarding the steps involved in transmission loss calculation are men-

tioned in appendix C.
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Chapter 5

Results

5.1 Numerical model

A numerical model was developed to validate the analytical methodology described in the previous

section. The numerical simulation was carried out under the ’Acoustic Harmonic FEM’ module of

the commercial simulation software LMS Virtual.Lab [23]. Each configuration was considered with

a short-length and a long-length model. The following table gives the number of nodes and elements

for each long-length configuration, and the maximum frequency up to which the model is valid. The

numerical simulation was done for a frequency range of 5 to 3000 Hz in steps of 5 Hz.

Table 5.1: Numerical model details

Type Configuration Nodes Elements Maximum frequency (Hz)

Long

SISO 22981 19576 3685

FIFO 23026 20302 3920

FISO 20701 17852 3616

Short

SISO 8296 6816 4378

FIFO 8318 7016 4175

FISO 9900 8346 4361

5.2 Analytical model

The analytical methodology described in Chapter 3 was used to develop a MATLAB® code to

calculate the transmission loss of the annular cavity for the three different types of configurations.

Two types of models were considered, one with short length and the other with long length for each

of the three configurations. For these TL curves, the modal series was summed up to m=3, n=3

and p=7.

The parameters and constants used in the code are given below in Table 5.2.
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Table 5.2: Dimensions and constants

Description Symbol and value
Outer diameter of the cavity b = 0.157 m
Inner diameter of the cavity a = 0.057 m
Long-length cavity L = 0.44 m
Short-length cavity L = 0.12 m
Location of side inlet l1 = 0.25L
Location of side outlet l2 = 0.75L
Location of face inlet δ1 = 0.0535 m
Location of face outlet δ2 = 0.0535 m
Diameter of inlet and outlet ports d1 = d2 = 0.032 m
Density of air ρ = 1.225 kg/m3

Speed of sound c = 340 m/s

5.3 Validation

5.3.1 Side-Inlet-Side-Outlet (SISO) configuration

Fig. 5.1 shows the comparison between transmission loss curves calculated analytically and numer-

ically. The plot is taken up to a frequency range of 5 to 3000 Hz. The cut-on frequency in this

case is estimated to be 1037 Hz which corresponds to the first circumferential mode. The maximum

value to TL occurs at close to 700 Hz, which is 79 dB. At, low frequencies, modes appear to be well

separated. Whereas, at medium frequencies, they are close to each other.
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Figure 5.1: Transmission loss of SISO long-length cavity
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Table 5.3: Mode shapes of SISO long-length annular cavity

Mode (0, 0, 0) (0, 0, 1) (1, 0, 0)

Frequency 0 Hz 386 Hz 1037 Hz

Mode Shape

Mode (1, 0, 1) (0, 0, 3) (1, 0, 3)

Frequency 1107 Hz 1160 Hz 1555 Hz

Mode Shape

Table 5.3 depicts the first six modal indices (values corresponding to m, n and p) of an SISO long-

length annular cavity and the corresponding acoustic natural frequencies and mode shapes. The

images denote the acoustic modeshape of the annular cavity.

Fig. 5.2 shows the comparison of analytical and numerical transmission loss of an SISO annular

cavity. The maximum value of TL predicted by the analytical method is 46 dB, which occurs at a

frequency of 1325 Hz. The L/b ratio for this short-length cavity is approximately 0.76. Due to a

short length, the modes of the TL graph are well spread over the range of 3000 Hz.
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Figure 5.2: Transmission loss of SISO short-length cavity

5.3.2 Face-Inlet-Face-Outlet (FIFO) configuration
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Figure 5.3: Transmission loss of FIFO long-length cavity

Fig. 5.3 shows the plot of analytical and numerical transmission loss for an FIFO annular cavity.

The plot range for frequency is from 5 to 3000 Hz. This being a long-length cavity, the L/b ratio is

approximately 2.78. The cut-on frequency for this cavity is also 1037 Hz, as the diameters remain

the same. The maximum value of TL is 54 dB occurring at 2480 Hz. Up to the cut-on frequency,

the FIFO long-length cavity has similar characteristics as that of an SEC muffler.

Table 5.4 shows some of the mode shapes and the corresponding acoustic natural frequencies of the

FIFO long-length annular cavity. The images denote the acoustic modeshape of the cavity.
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Table 5.4: Mode shapes of FIFO long-length annular cavity

Mode (0, 0, 0) (0, 0, 1) (0, 0, 2)

Frequency 0 Hz 386 Hz 772 Hz

Mode Shape

Mode (1, 0, 0) (1, 0, 1) (1, 0, 2)

Frequency 1037 Hz 1107 Hz 1295 Hz

Mode Shape
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Figure 5.4: Transmission loss of FIFO short-length cavity

The analytical and numerical transmission loss graph for an FIFO short-length cavity is shown in

Fig. 5.4. The TL curve has well separated modes since the L/b ratio is less than 1. The cut-on

frequency occurs at the first circumferential mode. (m=1, n=0, p=0). The maximum TL occurs at

1260 Hz with a magnitude of 56 dB.

5.3.3 Face-Inlet-Side-Outlet (FISO) configuration

Frequency (Hz)

T
ra

n
sm

is
si

o
n

 L
o

ss
 (

d
B

)

0 500 1000 1500 2000 2500 3000
0

20

40

60

80

100
Numerical
Analytical(1

,0
,4

)

(0
,0

,0
)

(1
,0

,0
)

(0
,0

,3
)

(1
,0

,3
)

(0
,0

,1
)

(1
,0

,1
)

Figure 5.5: Transmission loss of FISO long-length cavity

An FISO annular cavity has its inlet on the face and the outlet port on its side. The TL comparison

of analytical and numerical methods is shown in Fig. 5.5. There is a good agreement between the

two results. Again, in this case, the cut-on frequency is 1037 Hz. Thereafter, higher order modes
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start to propagate. As we move towards 3000 Hz, the modes appear to be closely spaced. The

maximum values of TL is 61 dB which occurs at two frequencies of 950 Hz and 2140 Hz.

Table 5.5: Mode shapes of FISO long-length annular cavity

Mode (0, 0, 0) (0, 0, 1) (1, 0, 0)
Frequency 0 Hz 386 Hz 1037 Hz

Mode Shape

Mode (1, 0, 1) (1, 0, 3) (1, 0, 4)
Frequency 1107 Hz 1555 Hz 1861 Hz

Mode Shape

Table 5.5 shows some of the mode shapes of the FISO long-length annular cavity. The mode index

for each mode shape is represented as a combination of m, n and p. The corresponding acoustic

natural frequencies are also mentioned.
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Figure 5.6: Transmission loss of FISO short-length cavity

For the short-length FISO annular cavity, the plot of transmission loss is plotted for a frequency

range up to 3000 Hz as shown in Fig. 5.6. The TL curve for a short-length has well separated modes

due to its L/b ratio being less than 1. The cut-on frequency in this case is also 1037 Hz, same as

the long-length cavity. The peak of TL occurs at 1295 Hz which is 66 dB.

5.4 Transmission loss of a circular duct
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Figure 5.7: Transmission loss of FIFO long-length circular duct

An annular cavity with no inner diameter resembles a circular duct. The same formulation can be

used to estimate the transmission loss of a circular duct by making the inner diameter as zero. Due
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to this, the radial mode shape function for a circular duct becomes to Eq. 5.1

R(r) = Jm(κmnr) (5.1)

This equation is same as that for an annular cavity with the term Cmn = 0. (Refer Eq. 3.21)

A comparison of analytical and numerical TL for a Face-Inlet-Face-Outlet (FIFO) circular duct is

shown in this section. All the remaining parameters are kept same as that of the annular cavity.

Fig. 5.7 shows the comparison between the numerical and analytical TL of a long-length FIFO

circular duct. The graph is plotted for a range of 5 to 2000 Hz. Both, the numerical and the

analytical results are in good agreement with each other and are found to be consistent with the

existing literature [15].

5.5 Comparison of 3D and 1D plane wave analysis
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Figure 5.8: TL comparison of 3D analytical method and 1D plane wave for an annular cavity
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The 1D plane wave propagation considers the acoustic pressure variation only in the longitudinal

direction. Th acoustic pressure remains constant at any given cross-section of the annular cavity. A

plane wave can be obtained by setting the radial mode order (m) and circumferential mode order

(n) to zero in the Green’s function.

Fig. 5.8 shows the comparison of 3D analytical and 1D plane wave transmission loss of an annular

cavity with arbitrary port locations. Three different configurations viz. SISO, FIFO and FISO with

long and short lengths are compared in the above figure. The 3D analytical TL is shown in black

color whereas the 1D plane wave TL is in blue colour. It is observed that the 1D analysis results are

in good agreement with 3D analysis predictions up to the cut-on frequency of higher order modes.

These higher order modes, which propagate through the annular cavity, cannot be captured using a

plane wave propagation.

The proposed formulation for calculating transmission loss of an annular chamber can also be used

for a circular duct and one-dimensional plane wave analysis.

5.6 Parametric study

5.6.1 Inner diameter

The inlet diameter (a) affects the performance of the annular cavity. The cross-sectional area and

the volume of the cavity are dependent on it. This prompts the investigation of the variation in the

TL curves according to the change in the inlet diameter. For this parametric study, four different

values of inner diameter are considered viz. 0.2b, 0.4b, 0.6b, and 0.8b. Frequency range for the

parametric study is changed to 5 to 2000 Hz as the results are validated with the numerical method.

Fig. 5.9 shows the analytical transmission loss for these four variations for the SISO configuration.

The rest of the parameters are kept same as described in the previous section.
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Figure 5.9: Analytical transmission loss for inner diameter variation
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Table 5.6: Cut-on frequency variation with inner diameter

Inner diameter (a) Cut-on frequency (Hz)
0.2b 1160
0.4b 1010
0.6b 895
0.8b 830

Form Fig. 5.9, it is seen that the inner diameter has a significant effect on the transmission loss

of the cavity. The acoustic natural frequency is a function of the inner diameter. As, the inner

diameter increases, the acoustic natural frequency decreases. Table 5.6 gives the cut-on frequencies

for different values of inner diameter. This is indicated by the shift of the TL curves towards the

Y-axis. Also a notable drop in the TL levels is observed due to the decreased area ratio by increasing

the inner diameter.

5.6.2 Port diameter

The port diameter is another factor which has an effect on the TL characteristics. A change in the

port diameter causes a change in the port cross-section area thereby causing an impedance mismatch.

For the following cases, the port diameter is varied from 8 mm to 64 mm. These characteristics

are plotted for an SISO configuration and the frequency range is changed to 5 to 2000 Hz since the

analytical method has been validated.
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Figure 5.10: Analytical transmission loss for port diameter variation

Fig. 5.10 shows the effect of increasing port diameter on the transmission loss. All the parameters

for the study are kept constant (Refer Sec. 5.3.1) except the port diameters of both, the inlet and

the outlet ports. From this study, it can be seen that as the port diameter is increased, the difference

in impedance of the annular cavity and the port reduces.Thus, the domes in the graph tend to get

flatter and a considerable decrease is seen in the transmission loss.
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Chapter 6

Conclusion

In this thesis, an optimum design methodology has been introduced for an EIEO muffler based on

the idea of continuous jet formation. This approach has been performed for a one-dimensional case.

This regression analysis based design has been used to calculate the modified dimensions of the

muffler. This showed that the jet formation concept is ideal for short chamber mufflers, with L/D

ratio less than 1.

For a short chamber muffler, as the length and diameter are of comparable magnitude, the plane

wave assumption does not hold. The high frequency waves, on account of their small wavelength,

tend to have a three-dimensional propagation. Due to these reasons, it becomes essential to analyse

the mufflers using a three dimensional study. Green’s function method is one of the ways for a

three-dimensional analysis, apart from FEM and BEM. An analytical approach has been developed

for an annular cavity using the Green’s function method. Using this study, the four pole parameters

of the transfer matrix have been calculated. Based on the analytical derivations, a MATLAB code

has been developed to estimate the transmission loss of an annular cavity with arbitrary locations

of inlet and outlet ports.

These results were compared with those obtained by finite element method. LMS Virtual.Lab was

used to numerically calculate the transmission loss of the annular cavity. Both, long-length and short-

length cavities were studied as a part of this thesis. The analytical and FEM results were found to

be in good agreement. The proposed formulation can also be used to calculate the transmission loss

of circular chambers as well as the 1-D transfer matrix.

A parametric study was done for two parameters; the inner diameter of the cavity and the port

diameter. The analytical TL curves for a=0.2b and a=0.4b match well with the numerical ones. As

the inner diameter increases to 0.6b and above, the numerical method shows a deviation from the

analytical TL prediction.

The port diameter affects the cross-sectional area of the ports to change with respect to the annular

cross-sectional area. This causes an impedance mismatch between the cavity and the ports. The

same variation is observed in the TL curves plotted for port diameters varying from 0.008 m to 0.064

m. There is a large difference in the impedance for small values of port diameter. This causes the

domes in the TL curve to be elongated and the range of TL is high. Whereas, the graph for a higher

port diameter show comparatively flatter TL curves due to a lesser difference in the impedance of

the ports and the cavity.
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Chapter 7

Future Scope

The three-dimensional analytical methodology for an annular cavity with various configurations has

been established and validated with numerical methods as a part of this thesis. This provides a new

approach to analyze the annular cavities where one-dimensional plane wave approximation cannot

be used. The following points can be taken up as a future scope of this research work:

• Establishing a three-dimensional transfer matrix for EIEO muffler considering it as a
combination of annular and circular cavities.

• Extending the same approach for analysis of an Extended Tube Concentric Resonator
(ETCR) muffler.
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Appendix A

Solutions of integrations

A.1 Integration over elliptic surface (I)

Surface integration over the side port area of the cavity is performed over an elliptic surface area of

the port as follows:

I1 =

∫
port i

cos θ cos (mθ) cos (kzpz) dSA

=

∫
port i

cos θ cos (mθ) cos (kzpz)
b

2
dθdz

=
b

2

∫ +bi

−bi

∫ θ2+
(

2ai
bbi

)√
(b2i−η2)

θ2−
(

2ai
bbi

)√
(b2i−η2)

cos θ cos(mθ)dθ

× cos[kzp(η + li)]dη

= πaibi cos(kzpli)×
[
Fmp

(
1

2
, cos[(m− 1)θ2]× J1(biβm−1,i)

biβm−1,i

)
+ cos[(m− 1)θ2]× J1(biβm+1,i)

biβm+1,i

]
(A.1)

where

ai is the maximum radius of the elliptic area i

bi is the minimum radius of the elliptic area i

βm,i =
√

( 2mai
bbi

)2 + k2
zp

Fmp{x1, x2} : conditional function =

x1, m = 1, p = 0

x2, otherwise
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A.2 Integration over elliptic surface (II)

I2 =

∫
port i

cos (mθ) cos (kzpz) dSA

=

∫
port i

cos (mθ) cos (kzpz)
b

2
dθdz

=
b

2

∫ +bi

−bi

∫ θ2+
(

2ai
bbi

)√
(b2i−η2)

θ2−
(

2ai
bbi

)√
(b2i−η2)

cos θ cos(mθ)dθ

× cos[kzp(η + li)]dη

= 2πaibi cos(kzpli) cos(mθ2)Qmp

(
1

2
,
J1(biβm,i)

biβm,i

)
(A.2)

where

Qmp{x1, x2} : conditional function =

x1, m = 0,p = 0

x2, otherwise

A.3 Integration in local polar co-ordinates

I3 =

∫∫
Jm(κmnr) cos(mθ)f(r, θ)rdrdθ

=
2πai

2

(κmnai + 2µmn)
(J1 (κmnai) + µmn) Jm (κmnδ) cos (mθi) cos (kzpli)

(A.3)

where

µmn =

1, m = 0, p = 0

0, otherwise

Note 1: The functions f(r, θ) and f(z, θ) used in the derivation are assumed to be equal to 1.

Note 2: The term CmnYm (κmnr) can be neglected from the integral as the port area is not annular;

but circular in cross-section.
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Appendix B

Creating a hexahedral mesh in

ANSYS workbench

This chapter explains the procedure to create an hexahedral mesh for use in LMS Virtual.Lab. As

explained earlier, an hexahedral mesh is computationally more efficient. Thus, an emphasis has been

given on meshing using hexahedral elements to reduce computation time.

1. Open ANSYS ®workbench. Create a new project using the Mechanical Model under the

Project Schematic window

Project Schematic → RMB → New Component Systems → Mechanical Model

Figure B.1: Mechanical model

2. As shown in Fig. B.1, the Engineering Data is predefined and can be left as default. Open

the Geometry tab to create the desired geometry.

3. The sketch for the annular cavity is shown in Fig. B.2. The dimensions are given according

to the FISO long-length cavity model. Refer Fig. 3.3 and Sec. 5.3.3 for geometry dimensions.

The inlet pipe will be constructed later for the ease of meshing. Using the Extrude command,

extrude the following sketch to desired length (in this case 0.44 m). To create the outlet pipe,

define a new plane at length 0.33 m. This plane will consist the sketch for the outlet pipe.

Again, the Extrude command is used to extrude the outlet pipe section. The only difference

is that the outlet pipe will be extruded upto the outer curved surface of the cavity.
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Figure B.2: Sketch for annular cavity

Figure B.3: Annular cavity with outlet
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Figure B.4: The completed geometry tree

Figure B.5: Creating virtual topology
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4. As shown in Fig. B.3, the annular cavity has a slot for the inlet pipe. To create the inlet

pipe, select the slot edge on surface SC (refer Fig. 3.3) and use the Extrude command. Here,

the operation Add Frozen is selected. Due to this option, the inlet pipe will be extruded as a

separate body. Give the extrusion length as 0.5 m. After completing all the operations, the

inlet pipe and the outlet pipe are combined together to form a new part. This makes sure that,

although the inlet pipe is a separate body, it is a part of the annular cavity. The completed

geometry tree will look like as shown in Fig. B.4. This completes the Geometry part of the

module.

5. Now, the Model can be opened for meshing. (Refer Fig. B.1). The option of Virtual Topology

is recommended for hexahedral meshing.

Model → RMB → Insert → Virtual Topology

This option enables the geometry to be split into a number of Virtual Cells by creating virtual

vertices and splitting the edges. This becomes an important tool of use due to its property

to split the geometry into several number of structured parts which is a feature of hexahedral

mesh.

Figure B.6: Splitting the edge at ”+”

6. Select the edge to be split. This will be denoted by a ”+” symbol. Then, click on the Split

Edge at + option as shown in Fig. B.6. Do this procedure for surfaces SB and SC . Similarly

all the edges can be split into different parts, as required. This operation will create virtual

vertices which are then used to split the faces.
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Figure B.7: Splitting the faces

Figure B.8: Split curved surface SA
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7. Fig. B.7 shows the use of Split Face at Vertices command. After splitting the edges in the

previous step, two virtual vertices will be formed. Select the two vertices at a time and click

on the Split Face at Vertices button. This will split the curved surface SA into two different

faces as shown in Fig. B.8. The above procedure is repeated for the complete geometry. The

final stage, after splitting all the faces appropriately is shown in Fig. B.9 and Fig. B.10.

Figure B.9: Geometry split into faces (shaded exterior view)

Figure B.10: Geometry split into faces (wireframe view)
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8. The MultiZone method is a meshing tool which can be used to create a hexahedral mesh. The

following steps will describe the procedure to define the parameters of this method.

Mesh → Insert → Method

Figure B.11: Definition of multiZone method

Figure B.12: MultiZone method for cavity
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9. Fig. B.11 shows the definition of MultiZone method. Here, the geometry needs to selected for

the method. Select the annular cavity and click Apply. The Method is changed to MultiZone.

The Element Midside Nodes are dropped. The source and target selection is changed to select

a manual source. Here, the end surfaces of the cavity (SB and SC) are selected as the source.

Rest of the parameters are left as default.

10. Similarly, another MultiZone method is defined for the inlet pipe. In this case, as the geometry

is a simple cylinder, the source and target selection can be kept as automatic.

Figure B.13: Details of mesh

11. Fig. B.13 shows the detailed parameters of the mesh. The Display and Defaults options are

set as default. The Sizing option consists of parameters which can be used to modify the

element sizing, adjust the span angle, the relevance centre, etc.

The Inflation tab includes all the parameters required to define a inflation layer if required.

These parameters are transition ratio, maximum layers, growth rate, etc. Inflation layers are

particularly useful to capture the boundary layer effect by creating layers of fine elements near

the boundary of the mesh.

The Advanced tab has the Element Midside Nodes option. This is a global setting for keeping

or dropping the midside nodes. This is set to Dropped.

Apart from the meshing, there are also methods available for mesh control. These typically

are the Sizing, Inflation and Refinement methods. These can be applied to faces or edges of

a body as required.
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Figure B.14: The completed hexahedral mesh

12. After defining all the required parameters, update the mesh. Fig. B.14 shows the completed

hexahedral mesh of the annular cavity. The inlet pipe being a separate body, is shown with a

different colour.

Figure B.15: Smooth connectivity
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13. The inlet pipe, although being a separate body, has a smooth node-to-node connectivity with

the annular cavity. The reason for this is shared topology. The inlet pipe shares its edge with

the annular cavity. This makes it easier for the software to automatically adjust the position

of nodes of two different bodies. Fig. B.15 shows the connectivity of the two bodies.

Figure B.16: The finite element modeler

Figure B.17: Exporting the model for use in LMS Virtual.Lab

14. The finite element modeler is used to export the mesh in .nas format for analysis in LMS

Virtual.Lab. As shown in Fig. B.16, transfer the model to finite element modeler and update

the project. Fig. B.17 shows the import summary of the mesh. As indicated by the import

summary, all the elements are of the same type i.e. linear hexahedrons. To export the mesh

in .nas format, select the Target System as NASTRAN. Then click on Write Solver File and

save the file to a desired location.
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Appendix C

Calculation of transmission loss by

LMS Virtual.Lab

This chapter explains the step-by-step procedure for calculation of transmission loss.

1. Open LMS Virtual.Lab. Start the Acoustic Harmonic FEM module. This will create a new

analysis window with a pre-defined tree.

Start → Acoustics → Acoustic Harmonic FEM

Figure C.1: Importing the mesh

2. Import the desired mesh model with a compatible mesh file format as shown in Fig. C.1

Links Manager → RMB → Import

After selecting the desired file, a window will open as shown in Fig. C.2. Select the working

units for Length and Mass as required. The rest of the units are preferably kept as defaults.

3. The imported mesh needs to be set as an acoustic mesh to carry out the acoustic analysis.

Nodes and Elements → Expand → (mesh-file-name) → RMB → Set Mesh Part Type → Set
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Figure C.2: Importing the mesh (2)

Figure C.3: Defining the acoustic material

as Acoustical Mesh Part

The displayed mesh changes its colour from green to blue after setting it as an acoustical mesh.

4. Define the acoustic material with properties Sound Velocity and Mass Density
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Materials → RMB → New Materials → New Fluid Material. . .

A new window shows up to input the values of sound velocity and mass density as shown in

Fig. C.3.

Figure C.4: New acoustic fluid property

5. The above created acoustic material needs to be assigned to the acoustic mesh. For this, a

new acoustic fluid property has to be defined.

Properties → RMB → New Acoustic Properties → New Acoustic Fluid Property. . .

As shown in Fig. C.4, a small window will pop up. The Application Region is the acoustic

mesh and the created material is applied in the Fluid Material selection.

Figure C.5: Inserting a group set
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6. The muffler cavity has an inlet and an outlet face. These faces need to be defined for further

simulation. This can be done by inserting a group set in the tree as shown in Fig. C.5.

Insert → Mesh Grouping → Group Set. . .

Figure C.6: Creating a new group

7. New groups can be defined in the above created group set. Fig. C.6 shows the new group

creation.

Group Set → RMB → Mesh Grouping → Auto-update Group. . .

8. A new window will open to specify the type of the group to be defined. Here, under Selection

by Geometry tab, Feature Angle method is selected. The inlet group parameters can be defined

in the new window. As shown in Fig. C.7, under Input Groups / Mesh Parts / CAD, select

the mesh under Nodes and Elements from the tree.

The inlet face selection is done at the Type Specific tab. Here, the Faces option is selected to

define the group. The Feature Angle is the angle between normals of two faces. By default,

this value is 10 deg. From the displayed mesh, click on one of the faces on the inlet as a

Starting Element. Then click on Apply. This will define the inlet group in the analysis tree.

Follow the same procedure for the outlet group as shown in Fig. C.8.

9. Create the acoustic mesh preprocessing set.

Insert → Acoustic Mesh Preprocessing Set. . .
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Figure C.7: Creating a new group (2)

Figure C.8: Defining the faces of the inlet and outlet groups
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Figure C.9: Defining the boundary conditions

10. Proper boundary conditions must be given to the inlet and outlet faces. For this, a boundary

conditions’ set can be defined.

Insert → Acoustic Boundary Conditions and Sources → Acoustic Boundary Condition and

Source Set. . .

In the simulation for transmission loss calculation, an input velocity (usually 1 m/s) is given.

Thus, for the inlet face, a velocity boundary condition is defined. Locating the above created

set in the analysis tree, a new boundary condition known as Panel Velocity Boundary Condition

can be created as described in Fig. C.9.

11. After creating the Panel Velocity Boundary Condition the analysis tree will look as shown in

Fig. C.10. In the Faces tab, the inlet face has to be selected as the application region of the

velocity. The Constant Values tab specifies the magnitude of the velocity to be applied at the

inlet. By default, the pre-set direction of velocity is into the inlet face (negative).
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Figure C.10: Defining the inlet boundary condition

Figure C.11: Defining the outlet boundary condition
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12. For calculation of transmission the outlet is modelled with an anechoic termination. For this

purpose, a new property is defined as the outlet boundary condition as shown in Fig. C.11.

Properties → RMB → New Acoustic Properties → Anechoic End Duct Property. . .

The Application Region is the outlet group defined in the analysis tree.

Note: This method of defining the outlet boundary condition is only applicable for circular/an-

nular cross-sections. For other types of cross-sections, the Absorbent Panel Property is used.

In this property the impedance value needs to be specified, which is the product of sound

velocity and the mass density of the fluid.

13. This completes the pre-processing or the problem definition in the software. To solve the simu-

lation, an analysis case known as Acoustic Response Case is created. The solution parameters

of the case are enumerated in Fig. C.12.

Insert → Acoustic Response → Acoustic Response Case. . .

Figure C.12: Setting up the acoustic response case
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14. The frequency range can be specified according to the users’ requirement in the Results Speci-

fications tab. Here the start value, the step size increment and the end value of the frequency

needs to be defined.

The Solving Parameters tab gives the choice for the type of solver and other multi-processing

options.After setting up all the parameters, go to the analysis tree and start computing the

solution.

Acoustic Response Case → Expand → Acoustic Response Solution Set → RMB → Update

Figure C.13: Defining the IO set

15. The Acoustic Response Case calculates various properties like input power, acoustic power,

radiation efficiency, absorptivity, etc. For further calculation, only the acoustic pressures at

the inlet and outlet are required. To acquire these pressures, an IO Set needs to be defined.

Insert → New IO Set

IO Set → RMB → Create Single IOPoint → New IOPoint. . .

Fig. C.13 shows how to pick a node ID on the corresponding face to create an IO point. These

points will be used for calculation of acoustic pressure.
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Figure C.14: Creating a vector to function conversion case

Figure C.15: Plotting the acoustic pressures

16. A Vector to Function Conversion Case is used to convert the previously calculated properties

to acoustic pressures at the inlet and outlet faces. Refer Fig. C.14.

Insert → Pre- and Post-Processing → Vector to Function Conversion Case. . .

Vector to Function Conversion Case → Expand → Load Vector to Function Solution Set →
RMB → New Function Display. . . → 2D Display → XY Plot (Refer Fig. C.15).

The values for acoustic pressure at inlet and outlet with real and imaginary components will

be saved in the Load Vector to Function Solution Set.
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Figure C.16: The load function editor

17. The Load Function Editor is a tool used to calculate the transmission loss using the inlet and

outlet acoustic pressures.

Insert → Functions Creator → Edited Load Function. . .

After selecting the above command, a new window will pop up. Click on the Values tab and

select Import a feature as shown in Fig. C.16. Here the acoustic pressure needs to be imported.

For this, select the Load Vector to Function Solution Set from the previously defined Vector

to Function Conversion Case from the analysis tree. Fig. C.16 shows four stack levels L1 to

L4. These will be used to store the acoustic pressure data. The transmission loss is calculated

using Eq. C.1.

TL = 20 log10

∣∣∣∣Pin + ρcVin
2Pout

∣∣∣∣ (C.1)

As stated before, the inlet velocity is considered negative by default setting. Thus, in the

above formula Vin will be equal to −1.

For ease of calculation, import the outlet pressure data first and multiply it by 2. Then, import

the inlet pressure data, add ρcVin, and store in stack L1. This will be the numerator. The

previous data in stack L1 will automatically move into stack L2. Then, using appropriate

buttons according to the formula, arrive at the transmission loss values for the corresponding

frequency values in a tabular form. The final edited function will look as shown in Fig C.17.
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Figure C.17: Transmission loss values

Figure C.18: Transmission loss graph as a function of frequency

18. Plot the graph of transmission loss from the Load Function Editor.

Edited Load Function Set → Expand → Copy of Load Vector to Function Solution Set → RMB

→ New Function Display. . . → XY Display
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